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I. INTRODUCTION 
In this new century, our society has been transformed or reshaped with advanced technologies in most 

fields such as education, telecommunication, sciences and so on.  This is because to improve the business 

strategy and to meet all the requirements easily and efficiently. Education is one of the important components in 

our life. E-Learning is defined as an Internet-enabled Learning in which the student can able to learn himself or 

herself.  With Information Technologies (IT), there is an emerging trend regarding the research and exploitation 

of E-Learning systems.  This sometimes related to virtual distance education, which may support the teaching-

learning process, through E-Mail, web pages etc. Now-a-days, Cloud Computing  plays a vital role along with 

E-Learning. These two technologies rising speedily and plays a powerful role in the field of education, learning 

and training.  It provides virtual environment to the students which will help them to learn easily.   

The Cloud Computing is a collection of services or resources that can be accessed remotely via the 

Internet.  Using this, the software developers can able to create, store and access the information by much more 

efficient way, in order to increase the access to communicate and also to decrease the cost.  Most organizations 

such as educational institutes, businesses and other industries are very excited to adopt this cloud computing 

services for cost saving, scalability, ease of use, time shifting, fault tolerance, broad access, and security and 

maintenance. 

Thus, in our research work, cloud-based services (SAAS) are utilized in order to implement the methodology.   

The algorithm in this paper, performs well to demonstrate how the software can be useful for different 

kinds of users of different concern and the performance evaluation also be given in the experimental results 

section.  

 

II. RELATED WORK 
Paul et al, in paper [1] described that Cloud computing is growing rapidly, with applications in almost 

any area, including education. E-learning systems usually require many hardware and software resources. There 

are many educational institutions that cannot afford such investments, and cloud computing is the best solution. 

The paper presented the positive impact of using cloud computing architectures upon e-learning solutions 

development. It focuses on the benefits of cloud computing for e-learning solutions and the e-learning project 

management challenges when this architecture is used. Sudhir et al, in paper [2] stated that the gaining 

popularity of erudition on the internet, the edifice of perfect web-based learning environment has become one of 

the hottest points on researching remote education. Cloud Computing and E-Learning plays a vital role and it 

supports the smart phone mobile users to perform their tasks effectively with paying less cost by utilizing the 

cloud-based applications offered by the cloud service providers. These technologies are aimed at running 
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applications such as word processing, spreadsheets, access database and many more provided by the internet 

service provider in the virtual environment while on the move by a flexible infrastructure as all the data and 

information is stowed in the cloud ambiance. The paper focused on how e-learning benefits the e-learners by 

using cloud computing services and presents e-learning approaches by using cloud computing. 

Fernandaz et al, in paper [3] stated in this contribution, they gave an overview of the current state of the 

structure of Cloud Computing for applications on e-learning. They provided details of the most common 

infrastructures that have been developed for such a system, and finally they presented some examples of e-

learning approaches for Cloud Computing that can be found in the specialized literature Deepan shu et al, in 

paper [4], stated in the paper that the use of cloud computing in the educational and learning arena, to be called 

‟Education and Learning as a Service” (ELaaS), emphasizing its possible benefits and offerings. It is essential 

for an educational and learning organization, with its budget restrictions and sustainability challenges, to use the 

cloud formation best suited for a particular IT activity. In the paper, web-based learning environment and the 

concept of cloud computing are discussed. The latest development of cloud computing. 

Nair et al, in paper [5], discussed that the popularity of learning on the internet, the construction of 

perfect web based learning environment has become one of the hot points on researching remote education. It is 

envisioned that, in the near future, cloud computing will have a significant impact on the educational and 

learning environment, enabling their own users(i.e., learners, instructors, and administrators) to perform their 

tasks effectively with less cost by utilizing the available cloud-based applications offered by the cloud service 

providers. Therefore, there is a need to redesign the educational system to meet the needs better. . E-learning 

systems usually require many hardware and software resources. There are many educational institutions that 

cannot afford such investments, and cloud computing is the best solution. They presented several case studies 

for educational clouds introduced by popular cloud providers which reflect the increasing interest in this new 

trend. They also discussed future challenges to cloud education. Robert Goodwin et al, in paper [6], stated that 

developments in computing are influencing many aspects of education. The purpose of the paper is to assess the 

potential value of cloud computing as a platform for e-learning. In particular, the paper will discuss how cloud 

computing is different from other forms of computing and what makes it unique. As well is this, the potential 

advantages and disadvantages of using cloud computing as a platform for e-learning will be outlined. Finally, 

the requirements of implementing cloud computing will be discussed, along with an assessment of the 

challenges to implementation, and some potential ways to overcome them. 

Abu et al, in paper [7], presented a creative environment derived from both virtual and personal 

learning environments based on cloud computing which contains variety of tools and techniques to enhance the 

educational process. The proposed environment focuses on designing and monitoring educational environment 

based on reusing the existing web tools, techniques, and services to provide Browser-based-

Application.Radhakrishnan et al, in paper [8], discussed that the popularity of learning on the internet, the 

creation of perfect web-based learning environment has become one of the hot points on researching remote 

education. It is predicted that, in the near future, cloud computing will have a significant impact on the 

educational and learning environment, facilitating their own users(i.e., learners, instructors, and administrators) 

to perform their tasks effectively with less cost by utilizing the available cloud-based applications offered by the 

cloud service providers. The paper discussed the employability of cloud computing in the educational and 

learning ring, to be called “Teaching and Learning as a Service” (TLaaS), emphasizing its possible benefits and 

offerings.Alberto Fernandez et al, in paper [9], gave an overview of the current state of the structure of cloud 

computing, and we provide details of the most common infrastructures that have been developed for such a 

system. They also presented some examples of e-learning approaches for cloud computing, and finally, they 

discussed the suitability of this environment for educational data mining, suggesting the migration of this 

approach to this computational scenario. 

Anwar et al, in paper [10] stated that the e-learning cannot entirely replace educators; it is merely an 

updating for technology, concepts, tools and ideas that gives new content in the field of education. The 

educators and students are playing prominent roles and contribute in developing and  making use of e-learning 

cloud. This unified learning approach is improving the educational act. E-learning cloud is a new journey of 

cloud computing technology in the field of e-learning, which is a future e-learning infrastructure that includes all 

the needed hardware and software computing resources engaging in E-learning. 

Zuev, in paper [11] stated that the article looks into methods and models that are useful when analyzing 

the risksand vulnerabilities of complex e-learning systems in an emergency management context. Definitions of 

vulnerability and emergency response capabilities, such as “VLE/PLE attack surface”, are suggested.  The 

article provided insight into some of the issues related to analysis of risks and vulnerabilities of e-learning 

systems George Yee, in paper [12] examined privacy and security issues associated with e-learning. It presents 

the basic principles behind privacy practices and legislation. It investigates the more popular e-learning 

standards to determine their provisions and limitations for privacy and security. Privacy requirements for e-

learning systems are explored with respect to the “Privacy Principles”. The capabilities of a number of existing 
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privacy enhancing technologies, include methods for network privacy, policy-based privacy security 

management, and trust systems. 

Sunil et al, in paper [13] stated that, apart from integrity enforcement, security enforcement in the 

whole system is the other crucial way to organize it. As internet is the backbone of the entire system which is 

inherently insecure, during transaction of message in E-Learning system, hackers attack by utilizing different 

loopholes of technology. So, different security measures are required to be imposed on the system. In the paper, 

emphasis is given on different risks called e-risks and their remedies called e-remedies to build trust in the 

minds of all participants of E-Learning system..  

 

III. PROPOSED METHODOLOGY 
3.1 Proposed Method 

The aim of this paper is to propose a methodology for implementing a cloud-based Learning system in 

a secured manner.  E-Learning is broadly used in different educational institutions to train and test the efficiency 

of the students.  In this research work,     methodology is proposed to satisfy the aim of the paper.  The 

description of the proposed method is given below: 

 

 
Fig-1: Cloud-Based E-Learning System 

 

E-Learning is mainly used in schools, colleges and companies in order to train the students.  This has to 

be carried out by developing software which contains all the educational contents in detail and in an easier way.  

The software must be of generalized as well as customized one, such that it can be utilized by all kinds of 

organizations and by all kinds of people.  Through this,   the individual development cost and testing cost for an 

organization will be reduced.  Thus,   development is required for a customized tool with cloud-based 

environment.  By using this tool, each organization can able to configure according to their requirements.   

In the methodology, the software developer develops a methodology by placing all the necessary 

contents and configurable tools into the E-Learning Server, which will come under the cloud environment.  The 

configurable tool  is the scenario and criteria that can be modified by an organization based upon their 

requirements.  The E-Learning clients can only be communicable with the Cloud services, which in turn, can 

switch the user to the appropriate server based upon their criteria.  Thus, the cloud-based E-Learning system can 

able to train the students in a much better way.   
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The information in the software developed is maintained confidentially.  The configurable tool can be 

designed by the organization in their own style based upon the requirements.  The contents that the students can 

learn are common for all organization, whereas to test the students, the organization undergoes to design the tool 

as per their requirements and criteria.  The requirements can be of either the test is theory-based or objective-

based.  If it is objective-based, then choose the type of answers: whether it is single choice or multiple choices.  

Also what are the scenarios that the test will contain and how the result can be calculated are all designed by the 

concern.  Based on the result, the ability of the student can be observed. The result type may be of just pass or to 

obtain 100% marks based upon the category of the exam conducted by an organization.   

 

XML File-1: 

 

 

 

 

 

 

 

 

 

 

 

XML File-2: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<?xml version=”1.0” standalone=”yes” ?> 

<Content> 

      <File> AAA </File> 

      <Category> Grade A/ B/ C </Category> 

      <Location> XXX/YYY </Location> 

      <Pg_Count> N </Pg_Count> 

</Content> 

 

 

<?xml version=”1.0” standalone=”yes” ?> 

<Exam> 

<Test> 

   <Exam_Name> Name </Exam_Name> 

   <Type> Type </Type> 

   <Qn_Count> N </Qn_Count> 

   <Ans_Choice> All/ Option </Ans_Choice> 

   <Type> Single / Multiple </Type> 

   <Choice> Checkbox/ Radiobutton </Choice> 

   <Result> Minimum Pass/ 100% </Result> 

   <Remarks> Retest / OK </Remarks> 

</Test> 

<Questions> 

    <One> 

        <Question> QQQ </Question> 

        <Option-1> AAA </Option-1> 

        <Option-2> BBB </Option-2> 

        <Option-N> CCC </Option-N> 

    </One> 

</Questions> 

<Test_Emp> 

<Emp_List> Emp Names </Emp_List> 

<Position> Position </Position> 

<Start_date> DD/MM/YY </Start_date> 

<End_date>DD/MM/YY </End_date> 

<Reminder> Yes/No </Reminder> 

<Distribution_List> Reminder Authority 

</Distribution_List> 

</Test_Emp> 

</Exam> 
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he first step of our proposed methodology is to develop content for the learning process by the experts 

and save it in a specified location. This file consists of the details such as file name, location, content category, 

number of pages and so on.In that specified location, the appropriate contents are developed in a word document 

or spread sheet or in a PowerPoint based upon the category. Upon developing the content, the next step is to 

develop a scenario to test the students in a configurable way. All the necessary details are developed and save it 

in an xml format.  Based on the file, the screens are created in any language, to test the student.   

 

The sample screen is given below: 

In this work, the main components of E-Learning system to teach the students in a cloud-based 

environment are exposed.  In this way, E-Learning system facing challenges over huge growth of users and 

services.  There are many benefits on using cloud computing based e-learning system.  Cloud based education 

will help the students, staffs, trainers, organizations and also the learners to a very high extent and can able to 

gather the information from multiple sources.  The features of the cloud computing platform are appropriate for 

the accessible from all parts of the world, so that it can be easily adaptable to the current education model.  By 

integrating the E-learning system into the cloud computational services,  the user can able to develop a 

methodology with good flexibility, scalability and in an easily configurable manner. 

 

 
Fig-2: Test Screen 

 

The advantages involved in our proposed method are: we can develop a content to conduct the course 

which will be common for all kinds of employee or students.  Then the trained students are tested for their 

efficiency.  There is no need to develop individual software by individual organization.  As the software can be 

developed based on the cloud-based services (SAAS), it can be accessed from anywhere, but in an authorized 

way.   

 

3.2 Implementing Security Components on our Methodology to Authenticate the Users 

As the aim of this paper is to provide the methodology in cloud-based E-Learning service to the 

organizations and users, there is a need to implement some security features in order to authenticate the users. 
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By   using the cloud-based environment, there may be large number of users can use this methodology in order 

to gather the information.  In that situation, some unauthorized users can also utilize this method in an unwanted 

way, such as to hack and hide the information of the organizations.  In order to prohibit such users,   some 

security components into the methodology are implemented. Thus our system can be viewed and used in a 

secured manner only by an authorized person.  The components are IP Address, Mobile Number and Session 

ID. 

These three components are unique for all the users which can able to provide security on the Cloud-

based E-Learning systems.  When the user enters into the site, along with their information, the user’s IP address 

and Mobile number can be obtained.  The Session Id is the unique Id which can be automatically created by our 

server.  By processing these three components, the server sends a temporary message to the user’s mobile which 

will be valid for only 20 minutes.  Within that time period, the user will provide the temporary login number to 

access the site further.  Only, if the temporary login number provided by the user seems to be correct, then the 

user can be treated as valid user and the server will allow them to access the site.  Otherwise, the user will be 

prohibited.   

The way of processing the three components to generate a temporary login number is described below:  

Upon getting the IP Address, Mobile number and Session Id, the user has to process the components by splitting 

them into some sub sections such as: 

 The IP Address consists of 4 parts, which has to be separated by means of dot (.).  Here   4 parameters are 

used .  Let it be a,b,c,d 

 

 Eg: 120.120.120.1 

Let a=120, b=120, c=120, d=1 

 The Mobile Number consists of 10 digits, which has to be divided into two sections, each section 

containing 5 digits. In this 2 parameters are used. Let it be m and n. 

Eg: 9756487961 

Let m=97564 and n=87961 

 

 The Session ID is the last parameter be p. 

Eg: Let p=104 

Finally, 7 parameters are to be added to obtain a unique number, which will be a temporary login id.   

X = a+b+c+d+m+n+p 

Eg:X=20+120+120+1+97564+87961+104 

X=185990 

 

Therefore, X=185990.  This is the unique temporary login id which can be send to the user mobile 

<9756487961>, which will be valid only for 20 minutes.  By providing this id, the user can access the e-learning 

system.   

Thus, by implementing the methodology, the user has to provide a secured Cloud-Based E-Learning 

system.  The methodology also consist an algorithm, which is given below: 

3.3 Algorithm 

Begin 

Step-1: Content Development 

Develop Content for creating E-Learning System 

Save the File in a specified location 

Develop an XML file containing the file details 

Step-2: Testing 

Set a test scenario to test the efficiency of the student 

Determine the exam type and category 

Determine the questions and answers 

Determine the Result type 

Step-3: Determining the Efficiency 

Determine the list of employee to be tested 

Set the time period to attend the test 

Determine the efficiency of the employee 

Step—4: Validating the Employee 

Allow the user to provide login details 

Obtain their IP Address, Mobile Number 

Generate a Unique Session Id 

Process the IP Address, Mobile Number and Session Id 
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IP = {ip1,ip2,ip3,ip4} //split with respect to dot (.) 

MBL = {mbl1,mbl2} // divide into 2 parts 

SID = {session} 

TEMP = {ip1+ip2+ip3+ip4+mbl1+mbl2+session} 

Send this TEMP to user mobile 

Set the time limit to 20 minutes 

If the user provide this TEMP within 20 minutes and match with our TEMP then 

Allow the user to next step 

Else Restrict the user 

End if End 

 

3.4 Architecture Diagram of a E-Learning System 

 
Fig-3: Architecture Diagram 

 

IV. EXPERIMENTAL RESULT 
In this computerized world, to train and test the employee or student, E-Learning system has been used.  

In order to accessible by all kinds of users and organizations, our proposed method utilizes the cloud-based 

services.  Our proposed work has been verified in several organizations to test the efficiency of our 

methodology along with our security features.   Various experiments has been carried out in various 

organizations such as IT company, Schools and Colleges and the result is verified.  In all that organizations, the 

students or employee has been undergoes to learn the content of the system and then they are asked to attend the 

test, which can be conducted by that concern.  Based upon the result, the efficiency of the student has been 

determined.  Comparing the result with the existing system, our proposed method of cloud-based e-learning 

system performs well.   
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Fig-4: Comparison Chart 

 

V. CONCLUSIONS 
In this work,   the main components of E-Learning system to teach the students in a cloud-based 

environment along with security features were exposed.  In order to avoid unwanted access from unauthorized 

users, the system with security enhancement was implemented.  In this way, E-Learning system facing 

challenges over huge growth of users and services.  There are many benefits on using cloud computing based e-

learning system.  Cloud based education will help the students, staffs, trainers, organizations and also the 

learners to a very high extent and can able to gather the information from multiple sources in a secured manner.  

The features of the cloud computing platform are appropriate for the accessible from all parts of the world, so 

that it can be easily adaptable to the current education model.  By integrating the e-learning system into the 

cloud computational services, the user can able to develop a methodology with good flexibility, scalability 

securable and in an easily configurable manner. 

 

REFERENCES 
[1]. Paul Pocatilu, Felician Alecu, Marius Vetrici, “Using Cloud Computing for E-Learning Systems”, Recent 

Advances on Data Networks, Communications, computers, ISSN: 1790-5190 
[2]. Sudhir Kumar Sharma, Nidhi Goyal, Monisha Singh, “Distance Education Technologies: Using E-Learning 

System and Cloud Computing”, International Journal of Computer Science and Information Technologies, Vol.5 
(2), 2014. 

[3]. A. Fernandez, D. Peralta, F. Herrera, and J.M. Benitez, “An Overview of E-Learning in Cloud Computing”, 

Workshop on LTEC 2012, Springer pp.35-46. 
[4]. Deepanshu Madan, Ashish Pant, Suneet Kumar, Arjun Arora, “E-Learning based on Cloud Computing”, 

International Journal of Advanced Research in Computer Science and Software Engineering, Vol 2, Issue 2, Feb 

2012. 
[5]. Bhruthari G. Pund, Sanil S. Nair, and Prajakta P Deshmukh, “Using Cloud Computing on E-Learning”, 

International Journal of Emerging Trends & Technology in Computer Science (IJETTCS), Vol 1, Issue 2, July-

Aug 2012. 
[6]. Faten Karim, Dr. Robert Goodwin, “Using Cloud Computing in E-Learning Systems”, International Journal of 

Advanced Research in Computer Science and Technology (IJARCST), Vol 1, Issue 1, Oct-Dec 2013. 
[7]. N. S. Abu El-Ala, W. A. Awad, “Cloud Computing for Solving E-Learning Problems”, International Journal of 

Advanced Computer Science and Applications (IJACSA), Vol 3, 2012. 

[8]. Radhakrishnan. N, Chelvan, N.P. , Ramkumar. D, “Utilization of Cloud Computing in E-Learning Systems”, 

Cloud Computing Technologies, Applications and Management (ICCCTAM), Dec 2012. 



An Efficient Methodology to develop a Secured E-Learning System using…. 

 
| IJMER | ISSN: 2249–6645                        www.ijmer.com                  | Vol. 7 | Iss. 7 | July. 2017 | 39 | 

[9]. Alberto Fernandez, Daniel Peralta, Jose Manuel Benitez and Francisco Herrera, “E-Learning and educational data 
mining in cloud computing: an overview”, Internation Journal on Learning Technology, Vol 9, 2014. 

[10]. Masud Md. Anwar Hossain, Huang Xiaodi, “An E-learning System Architecture based on Cloud Computing”, 
World Academy of Science, Engineering and Technology 62 2012. 

[11]. Vladimir I. Zuev, “E-Learning Security Models”, Management Informaion Systems, Vol. 7, Apr 2012. 
[12]. Khalil El-Khatib, Larry Korba, Yuefei Xu and George Yee, “Privacy and Security in E-Learning”, International 

Journal of Distance Education, Vol. 1, Oct-Dec 2003. 
[13]. Nikhilesh Barik and Dr. Sunil Karforma, “Risks and Remedies in E-Learning System”, International Journal of 

Network Security & its Applications(IJNSA), Vol. 4, Jan 2012. 


